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Welcome 

A helpdesk system integrated seamlessly within your Microsoft Office Outlook, transforming it from a simple email client 

to a fully-fledged service provider.  

This is an elaborate help documentation that will guide helpdesk managers and technicians alike how to install, 

configure, and work with support cases in matter of minutes. Graphic illustration and screenshots of the 

screen/forms are used with proper marking wherever they are required to drive down the point of the relevant 

topic.  
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1. Introduction  
You have a business that you aim one day to grow and be profitable. If you are one-person support team and have fewer 

customers, sure, you can provide resolution to their grievances by writing or speaking to them, without logging the details of 

the customer and nor documenting the nature of the problem. However, what happens if you have a large customer base? Of 

course, there will be multiple support staffs attending to high number of support requests. BUT… 

• How would each one of them remember who sent what and who needs what?  

• How would John know that Monica has already resolved this particular customer’s issue?  

• How would you prevent them from working on the same issue concurrently to avert duplicate effort?  

• What if Monica solved an issue virtually identical to a separate issue John is currently working on?  

• How would John know this issue has been already resolved, so he could use this information to reply to the 

customer’s issue?  

For strategic decisions and intelligence, senior managers would certainly like to know how many times this particular problem 

come up for this particular product has. How long has this problem been an issue for them? 

Why a helpdesk system? 

It is said that success of a business is measured against the level of customer satisfaction on sales and services. In fact, the 

higher the customer satisfaction is the repeated business it creates. This is one of the key reasons why successful enterprises 

have a dedicated help-desk team or call centers to cater to the queries and grievances of their customer base. But what 

makes a help-desk team productive and successful? Well for sure, choosing the right helpdesk system is the first step that can 

make all the difference. 

But how do you arrive to the decision of choosing a particular helpdesk system? Do you need a helpdesk database system that 

works standalone within your local network? Or do you need a web-based helpdesk to enable your scattered support 

personnel to work on troubled tickets? Or do you require a helpdesk that make uses of your existing email infrastructure such 

as Microsoft Outlook and Exchange? 

But why in Microsoft Office Outlook? 

Typically, an ideal helpdesk system should support the organizations’ internal logic and workflows, integrates easily and 

leverage existing infrastructures, caters to the support technicians on the move, enables automation and processing based on 

customizable rules and most importantly, should be easy to use with little or no training requirement. This is where a 

helpdesk system based on email client such as Microsoft Outlook scores over other type of support systems. This is because in 

most businesses, most support staffs use Outlook extensively – all day, every day for email communications, appointments, 

contacts, tasks etc. As they have relied that heavily on Outlook, it is only natural for them to turn Outlook to a sort of a 

ticketing system to support requests and calls from customers.  

Moreover, as Outlook provides quick access to company’s contacts, address books, mailboxes and public folders stored on a 

central Exchange server, it makes it much easier for support personals to track, collaborate and log support requests in 

Outlook. 

The problems with helpdesks based on Outlook 

Microsoft Outlook is a great productivity office application, something more of an indispensable companion for many 

businesses. However, Outlook itself is highly optimized for personal email exchange often falling short when it comes to 

providing a complete history of an event over time. When an email has been forwarded on to another helpdesk team 

member, the original owner loses insight into the progress. This has a serious implication, that is, in its original state, Outlook 

simply lacks the automation, reporting, reminders, and workflow to manage a support ticket request, which is critical for 

growing helpdesks looking to optimize and uniformly improve support staff/customer interactions. 

The Solution - Extending your Outlook 

The AssistMyTeam Helpdesk system for Outlook answers these limitations by integrating itself within the Outlook process (as 

an add-in) and extending it as a platform to collect, track and resolve trouble tickets while sharing this information with your 

entire team, all with ease. It brings all of help desk functionalities and automation and tightly integrates with the easy 

workflow of Outlook, thereby allowing users to work in the same way they do with emails. What you would get as an IT 

manager is high rate of user acceptance, yet low cost of operation, training and maintenance. 
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Helpdesk that is designed for Outlook 
 

The AssistMyTeam Helpdesk is an issue tracking and ticketing system that is available as an add-on for Microsoft Outlook. 

Integrated seamlessly within your Microsoft Outlook, it transforms Outlook from a simple email client to a fully-fledged 

service provider. Using your inhouse Microsoft SQL Server or cloud Azure SQL as repository for storing support cases, it 

provides support staffs with all the necessary tools to log, collaborate, analyze and assist in the resolution of help desk issues. 

Various medium of communication supports automated messaging and notification requiring no human inputs, making it 

possible to integrate customer relationship management (CRM) processes in core help desk functionalities 

With inbuilt support for advanced statistics and varied reporting options, support managers can evaluate the performance of 

the helpdesk and in-turn ensures timely decision making for improved service.  

To sum up, AssistMyTeam Helpdesk improves the efficiency of the help desk to enable faster response time and higher 

productivity for your organization at lower operating costs. After all, the bottom line for your help desk team is for your end-

users to receive better and timely service. 

Benefits for your organization: 

 Work on cases in your Outlook as if you would work on emails 

 Single enterprise-wide view of support cases, callers, problems and resolutions 

 Little or no training requirement on the part of your support technicians 

 Centralized data storage on Microsoft SQL Server or Azure - efficient platform for collaboration 

 Enable integration with Active Directory  

 Common point-of-call for your callers 

 Structured workflow for all helpdesk activity  

 Freeing up valuable human resources by automating cases logging, sending notifications etc. 

 Higher productivity and increased "up-time" for support staffs  

 Organized state of cases means faster tracking requests 

 Identify problem areas and increase helpdesk efficiency  

 ‘Do more with less’ - affordable one-time fee with enterprise-wide license  

 

Benefits for your customers:  

 Always in communication loop via the power and ease of automated email/messaging 

 Inspires confidence to the help desk service 

 A knowledge base that can be searched through for resolution 

 Check on the progress or status of the case via web 

 Request support in a standardized way through email  

 Case gets resolved in a timely manner and hence customer satisfaction 

 Helps in building trust and loyalty in your brand 
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How It Works?  
AssistMyTeam Helpdesk System consists of two separate installs – Managerial and Agent. 

 

• The Managerial install is for helpdesk administrator who would configure and maintain the global configurations, drop 

down lists, templates etc. in the helpdesk SQL database. 

 

• The Agent install is for the technicians to enable them to log, raise and work on support cases in Outlook. 

 

Each of this tool is installed on individual computer as an extension to Microsoft Outlook and only relies on Microsoft Outlook for 

the front-end and a network SQL or cloud Azure database, as the back-ends.  

 

 
 

Step 1 
Manager creates a central helpdesk 

database 

After the managerial tool is installed, helpdesk 

administrator will be given a choice of database 

options where all the cases, articles, templates and 

other settings data will be stored centrally.  

Database options include Microsoft SQL Server, 

Microsoft Azure (cloud SQL server).  
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Step 2 
Manager configures helpdesk settings 

and drop downs 

Helpdesk administrator defines drop-down lists 

such as technicians, callers, problems as well as 

emails templates, messaging options etc. With 

these global settings, manager can streamline 

the behavior on how all technicians work on 

support cases in Outlook. 

 

 

 

Step 3 
Technician installs Agent add-in 

The Agent tool consists of an Outlook add-in 

that has all the logic and functionalities of the 

helpdesk application. Each technician of the 

helpdesk who would work on support cases 

needs to install the AssistMyTeam Helpdesk 

Agent tool. 

After a successful install, you will see that 

dashboard panel, toolbars or ribbons are 

added in the explorer and inspector windows 

of Microsoft Outlook. 

Note: Apart from the managerial tool, helpdesk 

administrators also need to install the Agent tool if they 

have to work on support cases themselves. 
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Step 4 
Caller submits support request via 

email or phone call 

An end-user experiencing technical challenges 

contact helpdesk requesting for support by 

sending an email or by making a phone call. 

These support requests are then logged and 

converted to cases in Outlook.  

Further details and drop-down lists (such as the 

classification of problems the request falls into) 

can then be set, by a supervisor or manager. 

 

 

 

Step 5 
Assign technicians to the case 

Typically, a manager or senior technician assigns the best 

technicians to the case for fulfillment of the service and 

speedy resolution.   

Furthermore, in the helpdesk settings, administrator can link and associate individual technician to a caller, or to a problem type 

such that when a new support request email is received, if there is a match between technician and the caller (read as sender), or 

if a problem type is found in the email subject, the associated technician will get assigned automatically to the case. 

Assigned technicians then get notified through an automated email. Optionally, the due date of the case is entered into the 

personal calendar of the technicians' mailbox. 
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Step 6 

Technicians collaborate to resolve the case 

The assigned technician then proceeds to fulfill and resolve the case in Outlook. Helpdesk manager may set due date and other 

deliverables on the particular case for the assigned technicians, for quality check purposes. Further correspondence to the caller 

might follow (in the form of emails, phone calls). All activities related to the case are logged and technician can fill time spent and 

assign additional technician if needed. All email conversations and notes can be accessed and tracked right from the case form 

itself, without the need to scan through your Inboxes for past replies. 

 

Step 7 

Caller follows-up via email 

The caller can reply back to email from the helpdesk and the response automatically triggers an escalation on that particular 

support case. If a response from the caller on an existing case is received, the concerned technicians are notified automatically. If 

the case has been resolved, AssistMyTeam Helpdesk automatically re-opens and marks it as an ongoing case. 
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Step 8 

Technician closes case after providing a 

resolution 

Once every parameter of the caller's request has 

been fulfilled, a case be closed. At the same time, 

the caller gets notified automatically on the 

closure of the case. 

 

  

 

Step 9 

 Technician adds resolution to knowledge base 

A closed case can be a good source of future reference and technician can create a new knowledge base entry based on the case. 

It is then available in the list of articles under the integrated knowledge base, categorized and sorted, ready for your technicians 

to draw from when similar issues arise. Additionally, helpdesk administrator can choose to publish these articles to their website 

or intranet to provide first level support to potential support requests from end-users. 
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Step 10 

Manager generates statistical and trend reports 

To identify problem areas and increase helpdesk 

efficiency, senior management runs the 

statistical tool from time to time, collecting 

valuable intelligence and trends and generating 

meaningful reports.  

 

For day to day knowledge of the helpdesk, they 

can generate summary reports to get appraisal 

on the current happenings on the helpdesk and 

track recent cases generated, worked, closed or 

reopened. 
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2. Requirements  
AssistMyTeam Helpdesk is available right inside your Outlook unlike any other standalone application and web-based help desk 

software. It can be easily deployed through an installer (manually or via a group policy object with MSI) across the entire 

organization.  

 

Please make sure that your system meets the following requirements before installing AssistMyTeam Helpdesk for Outlook: 

Windows Version  Windows Vista, 7, 8, 8.1, 10, 11. Both 32-bit and 64-bit OS are supported.  
  

Outlook Version  Outlook 2019, 2016, 2013, 2010. AssistMyTeam Helpdesk operates directly inside the 
Microsoft Outlook application (using Microsoft's "COM add-in" technology). Outlook 
Express is not supported.   
  

Database  

  

All versions and editions (including Express edition) of SQL Server are supported including 

cloud services such as Amazon RDS and Microsoft Azure SQL.  

 

.NET Framework  Microsoft .NET Framework 4.6.1  

 

  

.   
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3. Installation  
AssistMyTeam Helpdesk System consists of two separate installs – Managerial and Agent.  The managerial install is for helpdesk 

administrators who would configure or maintain the helpdesk settings, add or remove drop down lists, customize email templates 

etc. 

 

Note: If administrators need to work on support cases, then the agent tool also needs to be installed, apart from the managerial 

portion 

Download link: SETUPS 

There are two different setup types: 

For 'Per User Installation' (ideal for standalone single user/workstation) 

AssistMyTeamHelpdeskSetups_x86.zip (for 32-bit Outlook 2010, 2013, 2016, 2019) 

AssistMyTeamHelpdeskSetups_x64.zip (for 64-bit Outlook 2010, 2013, 2016, 2019) 

For 'Per Machine Installation' (ideal for installing on Citrix and Terminal Servers) 

AssistMyTeamHelpdeskSetups_x86_Citrix.zip (for 32-bit Outlook 2010, 2013, 2016, 2019) 

AssistMyTeamHelpdeskSetups_x64_Citrix.zip (for 64-bit Outlook 2010, 2013, 2016, 2019) 

The downloaded zip file contains 3 files: AssistMyTeamHelpdeskManagerSetup_xXX.exe, 

AssistMyTeamHelpdeskAgentSetup_xXX.exe and VersionInfo.txt where ‘xXX’ can be either x86 (32-bit Outlook) or x64 (64-bit 

Outlook) 

Extract these file contents to a file folder. It is recommended that you place the setup files on a shared network folder, such that all 

users can have access to it, and ease the installation and upgrade process. 

Per User Installation and Per Machine Installation 

In Per User Installation, both the Manager and Agent installs are performed 100% on the local system and nothing is installed on 

your Exchange or Windows Server. Further, this install is intended to serve only the current logged on user of the 

system/workstation and will be installed under the user's application data folder (instead of Programs Files folder) and no elevated 

permission is required (This is known as per user installation). So, there won't be a prompt from UAC to allow this install unless you 

change the install directory to say, Programs Files which will warrant an elevated permission/UAC prompt. If the same system is 

used by multiple technicians, each user needs to install AssistMyTeam Helpdesk add-in on their profile with the default installation 

folder location. 

Per Machine Installation: If you have the need to have a single install that serves all users of the system (i.e., per machine 

installation, which technically means the files will be installed under Program files folder and the add-in will be registered under 

HKEY_LOCAL_MACHINE registry hive rather than HKEY_CURRENT_USER), download the Citrix/Terminal Server version of the 

setups to perform a per machine installation. 

 

Further, the Administrator setup is of two different variants - one each for 32-bit Outlook and 64-bit Outlook 

For Per User Installation: 

AssistMyTeamHelpdeskManagerSetup_x86.exe (for 32-bit Outlook 2010, 2013, 2016, 2019) 

AssistMyTeamHelpdeskManagerSetup_x64.exe (for 64-bit Outlook 2010, 2013, 2016, 2019) 

 

For Per Machine Installation: 

AssistMyTeamHelpdeskManagerSetup_x86_Citrix.exe (for 32-bit Outlook 2010, 2013, 2016, 2019) 

AssistMyTeamHelpdeskManagerSetup_x64_Citrix.exe (for 64-bit Outlook 2010, 2013, 2016, 2019) 

  

https://www.assistmyteam.com/helpdesk-addins/download-setup/team-helpdesk-for-outlook/


 

 

 Back to TOC 

P
ag

e1
3 

Managerial Installation  
 

The managerial installation consists of an add-in that is exclusively designed for configuring and maintaining the settings of 

the helpdesk. It has to be performed by the helpdesk administrator/manager before the agent tool is installed on every 

technician's system. 

  

Step 1. Run the AssistMyTeamHelpdeskManagerSetup_xXX.exe to start the installation. Click 'Next' to Continue. If Outlook 

2010 or later is not installed, the setup wizard will not be able to proceed. Please also ensure Outlook is shutdown (if already 

running or active in the task manager) as the setup has to install an Outlook add-in. 

 

 
 

Step 2. Select the appropriate destination folder where the application files will be installed. If you change the default folder 

path, please make sure you have appropriate permission.  

(Note: by default, it will be installed under your application data folder) 
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Step 3. Click 'Next' to continue with the file’s extraction. It just takes a few minutes to complete the whole copying process 

  
  

Step 4. Click 'Finish’. This ends the files installation process in your system. Now start Microsoft Outlook 
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Step 5. Start Outlook (restart if it was already running during the files installation). As soon as Outlook is loaded, you will be 

prompted with the following database connection dialog box: 

 

Now, the final step is to choose a database where all the settings, templates, cases, articles and other helpdesk data will be 

saved. Supported database options are: Microsoft SQL Server (default) and Microsoft Azure SQL. 

 

Using Microsoft SQL Server 
 

This is the default recommended database. SQL Server Express edition is also supported. 

You need to provide the Server name as it is mandatory. The Database name is optional. If it is left empty, a new database 

with the name ‘AssistMyTeamHelpdeskDB’ would be created. If your SQL server is configured to use windows authentication 

(NTLM), then you can check the ‘Use Integrity Security’ option to let Windows manager the credentials to access the 

resources on the SQL server.  

Permission for Technicians/Agents on the SQL database 

Each of your helpdesk users/technicians should have both db_datareader and db_datawriter permission on the Helpdesk SQL 

database. 

 

 

 

NOTE: When choosing a SQL server database for Helpdesk System, if you are not using the ‘Integrated Security’ (also known 

as Windows Authentication, or NTLM authentication), then it is very important that each user or agent has knowledge about 

their SQL username and password so that they can enter them while making the first-time connection with the helpdesk 

database with their installed helpdesk add-in in Outlook. 
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Using Cloud based SQL Server database 

 

You can also use cloud-based SQL server service instead of on-premise such as Amazon RDS cloud service (They offer both 

free and paid accounts. For more, refer to https://aws.amazon.com/rds/). For instance, below is our test MS SQL account with 

Amazon RDS. Once you have signed up and created a MS SQL database, input the endpoint URL as server in our app. Make 

sure, you suffix the port number after the endpoint as “,1433” so that the full URL in the Server name would be 

‘XXXXXXXXXXXXXXXXXXXXXXXXX.rds.amazon.com,1433’. 

 

 
 

And here is screenshot of the RDS server to use from the RDS member panel. 

 
 

  

https://aws.amazon.com/rds/
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Using Microsoft Azure SQL 
 

Azure SQL Database is a cloud-based relational database service from Microsoft, which is based on SQL Server database. This 

option is ideal for helpdesk that have technicians scattered or working remotely in different locations but have access to the 

web. 

 

NOTE: If no database name is mentioned, the helpdesk add-in will create a new database in your Azure SQL server, by the 

name of 'AssistMyTeamHelpdeskDB’. 

 

Step 6. With the database creation and configuration done, you will be given a choice to load a sample dataset of cases, KB 

articles and drop-down lists (problems, statuses, callers, agents etc.). We strongly feel you will be able to learn and get 

familiar with the helpdesk add-in very quickly with the sample dataset and hence, we recommend that you load them. If 

chosen, 5 each of cases, KB articles, callers, drop-down lists etc. will be loaded into your new database. You can, of course, 

remove them later without much difficulty. 

 

Once done, you are almost ready. If you want to work on the cases in your Outlook, you and other agents will also need to 

install the helpdesk agent add-in as well. 
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4. Managerial Settings   
The Helpdesk Manager include list managers to customize the contents of all drop-down boxes on the help desk form, email 

templates for outgoing emails, notification options, custom fields etc. Besides managing the settings and drop-down lists, it is 

responsible for monitoring service compliance on active cases and automatic escalation to assigned technicians.  

 

AssistMyTeam Helpdesk Manager Menu 

The AssistMyTeam Helpdesk menu serves as the gateway for launching most of the functionalities and tools available in 

AssistMyTeam Helpdesk for Outlook. In Outlook 2019, you would find the AssistMyTeam Helpdesk Manager menu in the 

backstage file button, as shown below. 
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4.1 Helpdesk Settings Data Source 
 

Being a groupware solution, AssistMyTeam Helpdesk add-in requires that it stores the data – cases, articles, callers, templates and 

other global configurations on a dedicated database, accessible to all technicians of your helpdesk. So, when you install the 

managerial tool first time, you will be prompted to choose a SQL database. 

 
 

Supported database options: 

 

 

i) Microsoft SQL Server  

It is recommended to use a dedicated inhouse SQL Server database option, as it gives a better performance and is easily 

scalable. For more information on using SQL Server with AssistMyTeam Helpdesk, refer to section ‘Installation > SQL 

Server database‘. 

ii) Microsoft Azure SQL 

Azure SQL Database is a cloud-based relational database service from Microsoft, which is based on SQL Server database. 

This option is ideal for helpdesk that have technicians scattered or working remotely in different locations and have no 

but have access to the web. For more information on using Azure SQL with AssistMyTeam Helpdesk, refer to section 

‘Installation > Azure SQL database‘. 

 
Importing Database Configuration from file - Database configuration file (*.dbconfig) can be imported on new machine 

or new agent from 'Helpdesk Settings Data Source' panel. And the manager/agent addin on that system will read the 

location and connect to the configured database automatically  
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Saving database configuration to file: Database configuration can be saved to a file (having *.dbconfig file extension) 

from Helpdesk Settings Data Source panel and manager can share/deploy this .dbconfig file to other agents/users (say, 

via email or file server) so that individual technician can import that .dbconfig file to connect their manager/agent addin 

to the correct Helpdesk database in their respective Outlook. 
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4.2 Agents List  
 

AssistMyTeam Helpdesk needs to be fed with the detail of the agents that would be working on support cases. In this list, the 

agent’s name and email address are mandatory fields and should be unique for each agent that you entered. 

  
 

 
Import agents from Global Address List/Active Directory - Most likely, you might already have contact details of the 

agents in the exchange global address list. Use the 'Import...' button to display the address book and select those contacts 

that you want to import. The Agent's name, email, telephone, mobile fields would be then automatically filled in the grid. 
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4.3 Callers list  
 

AssistMyTeam Helpdesk maintains the detail of the callers that had requested for support in a list. The caller's email address is 

a mandatory field and should be unique for each caller that you entered.  

 

  

 

Import callers from Global Address List/Active Directory - Most likely, you might already have contact details of 

the callers in the exchange global address list. Use the 'Import...' button to display the address book and select 

those contacts that you want to import. The contact's name, email, company, address, telephone, mobile fields 

would be then automatically filled in the grid. 

 

Default Agent - Each caller entry can also take a default agent. This is useful if you want to dynamically assign this 

agent to a case generated from an email send by a particular caller. This setup triggers the automatic notifications 

to the assigned agent. 
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4.4 Categories, Types and Statuses Management  
 

Problem management is critical to ticketing system. After detecting a problem, helpdesk manager should log and categorize 

the problem into a main category and secondary type. This step is beneficial in several ways.  

• Allows the helpdesk to sort and model incidents that occur regularly. 

• Allows for automatic assignment of prioritization such as agents).  

• Ability to gather and report on helpdesk tickets data. This data allows the organization to not only track problem 

trends, but also to assess its effect on service demand and helpdesk capacity. 

With AssistMyTeam Helpdesk, you can maintain a list of problems (as categories, types, statuses) that is representative of all 

possible incidents reported by your end users. 

 

 

Problem categories list 

Gather all the problem areas that your support team will be attending to and feed them into the 'Category' field. 

You can also specify the default hourly rate for each problem category, so that, when using statistics, you can 

consider this category rate. 

 

Problem statuses list 

As agents start working on assigned cases, over time, they may need to update the state of the tagged problem so 

that managers can track and plan additional resources if needed to resolve that particular case. Such a list of status 

flags can be specified. 

The color code column allows you to associate a 

color with a status. And case item in Outlook that is 

tagged with a problem status will be colorized with 

the associated color.  

You can choose from one of the 20 colors 

supported by Outlook for color coding Outlook 

items (via Categories field of the Outlook item).  

To specify a color code for a status, double-click the 

corresponding second cell (color code column).  

When you set the status of the case manually or when the add-in does that automatically (using the default status 

values), you will see that the status column on the dashboard panel are color-coded accordingly. 
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(NOTE: For color coding of cases with status color code, you need to enable the option 'Allow Color Coding of Case 

items based on the status of the case' from AssistMyTeam Helpdesk Manager > Advanced Options > General tab)  

And if you view the case, you will also see the color bar in the header. 

 

 
 

Problem types list 

The problem types are sub-category items that fall within the domain of a problem area/category. Hence, each problem 

category has a specific list of problem types that an agent or manager can choose from and tag a support request case.  

 

In the Outlook case and knowledge base form, when an agent selects from the problem category drop down, it will load this 

tier of problem type lists in the type drop-down box. These nested tiers of categories/types are complete customizable to 
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your organization's support model and act as somewhat of a guiding decision tree for the caller (when submitting online 

service request) and agents etc. These also assist in providing high-level information to help desk managers in automatic 

assignment of cases to the correct agent. 

 

 

Problem Category to which this problem type belongs to. If a particular problem type is applicable to all problem 

categories, leave it as empty. That is, if you have a common problem type for all Problem categories, you don’t 

need to add the same problem type for each category. Just leave the Problem Category column empty for that 

problem type. 

 

Default time (in minutes) under which the particular problem is expected to be fixed/resolved. 

 

Code – This is an abbreviated code that you can define for each problem type. This could be one of the tracking 

codes that helpdesk manager can configure for embedding into the subject of the case item (along with the case 

ID) for easy recognition and tracking. 

 

Default Agent who has expertise on that problem. You can also assign multiple agents to a problem type. And 

these default agents could be automatically assigned to cases that are tagged with this problem type.  
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4.5 Custom Fields  
 

You can deploy any number of custom fields that take different data types and these fields will be available in the Custom 

fields tab of the case form in Outlook, such that, when you are raising a ticket from an email or phone call, you can fill in the 

value directly. All defined custom fields are available in summary reports and OLAP Statistics tool.   

You can define such custom fields that take the following data types:  Text, Number, Currency, Yes/No, Date/Time, Note or 

drop-down List. 

 

 

 

Custom fields can be of 6 different data types as displayed in the image above:  

Currency, Date/Time, Numeric, Text, Yes/No, Note. 

You can add any number of Custom fields as required and they will all appear in the case form in Outlook. 

 

You also have the option to even mark a custom field Mandatory, so that without filling the mandatory fields, a case 

couldn’t be mark completed. Once a field is marked mandatory it would be displayed in red color so that user can 

identify the mandatory fields. 

 

 

Custom List - The titles of these custom list can be edited to get the proper meaningful label that signifies the 

information the field store. For example, the first drop-down field can be titled as ‘Client’ and the administrator can fill 

up the names of all their clients for which projects are contracted for.   
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When you open a case in Outlook, the custom fields are available to collect further data on the caller or problem or related to the 

case in general. 
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4.6 Templates Manager  
 

AssistMyTeam Helpdesk uses various templates for sending out notifications and reminders to callers and technicians - both 

manual and automatic. Each template takes the HTML format. There are a whole lot of notification options for different 

events such as when a case is created, changed or resolved, or when an agent is assigned to the case, or when the due date 

has lapsed etc. Automated emails are sent out directly when a relevant event occurs and the whole exercise is transparent to 

the agents. 

 

 
 

 

A list of all templates used for print, email notifications. The followings are the available templates: 

 

Template Purpose 

Print HTML template used when printing the support case item in Outlook 

 

Email caller from case form HTML template used when contacting the caller of a case 

 

Email technicians from case form HTML template used when contacting the technician responsible for a 

case 

 

Email caller on case closure HTML template used in the automated email to the caller to notify 

about the successful resolution to the allotted case 

 

Email technicians on case assignment HTML template used in the automated email to the technicians to 

notify when a case is assigned 

 

Email technicians on case reopening HTML template used in the automated email to the concerned 

technicians when a resolved case has been re-opened 

 

Email technicians on due-date lapse HTML template used in the automated email to the concerned 

technicians when the due date of a case is about to be overdue 

 

Email technicians on respond by date 

lapse 

HTML template used in the automated email to the concerned 

technicians when the respond by date of a case is about to be overdue 
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Email caller on technician assignment HTML template used in the automated email to the caller when new 

technicians are assigned or existing ones changed 

 

Email technicians on caller reply  HTML template used in the automated email to concerned technicians 

to inform about new replies from the caller 

 

Email Technicians on KB publication HTML template used in the automated email to all helpdesk staffs to 

inform about new KB publication 

 

  

 

The actual template in its raw state. A WYSIWYG HTML editor with which you can customize the contents, apply 

HTML formatting as well as insert the placeholder variables. The look and feel as well as the buttons and 

functionalities are similar to Microsoft FrontPage authoring tool. 

 

 

Subject of the active template. It is also customizable and can take placeholder variables. 

 

A list of all placeholder variables available for inserting into a particular template. In runtime (that is, when the 

actual email is generated from the template), the enclosed variables will be substituted by their corresponding 

values.  

 

The followings list all the supported variables: 

 

Variable Purpose 

CASE_BODY Description of the support request case 

CASE_ID Case Number of the generated support case 

CASE_SUBJECT Subject of the email or the support case 

CASE_CREATED_BY The help desk staff that created/logged the 

support request 

CASE_RECEIVED_DATE Date and time the email was received 

CASE_CREATED_DATE Date and time the support case was 

created/logged 

CASE_CATEGORY Problem category to which the case belongs to 

CASE_TYPE Problem type to which the case is related with 

CASE_STATUS Status of the case with regards to the problem 

CASE_TIMESPENT_DESCRIPTION Description on each time that an agent spent in 

working on the case 

CASE _TOTAL_TIMESPENT Total time spent (in minutes) on the case 

CASE_NOTES Nodes added on the case by technicians and 

managers 

CASE_CALLER_NAME Name of the caller who had requested for help 

CASE_CALLER_EMAIL Email address of the caller 

CASE_CALLER_PHONE Telephone number of the caller 

CASE _CALLER_MOBILE Mobile number of the caller 

CASE_CALLER_ADDRESS Full address of the caller 

CASE_CALLER_COMPANY Company name of the caller 

CASE_AGENTS Agents assigned to the case 

CASE_EMAILS_AGENTS The email addresses of the assigned agents 

CASE_MOBILES_AGENTS The mobile numbers of the assigned agents 

CASE_DUE_DATE Due date assigned to the case within which the 

case has to be resolved 

CASE_RESPONSE_DATE The date within which the first response to the 

caller should have been made by the assigned 

agent 

CASE_FIRST_RESPONSE_DATE The date the first response to the caller was made 

after the case was logged in the system 

CASE_PRIORITY Priority of the case 

CASE_AGE The age of the case 
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TIME_NOW Current date and time 

CASE_REPLIED_EMAIL_BODY Description body of the caller replied email 

CASE_REPLIED_EMAIL_SUBJECT Subject of the caller replied email 

KB_ID The unique ID of the KB article 

KB_BODY Description body of the newly published KB 

article 

KB_SUBJECT Subject of the newly published KB article 

KB_CATEGORY Problem Category of the newly published KB 

article 

KB_TYPE Problem Type of the newly published KB article 

KB_CREATED_BY The person that created the KB article 

KB_CREATED_DATE 

 

Creation date of the newly published KB article 

  

 

Reset button – click this to reset any changes made to the selected template and revert back to the original 

template content. 
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4.7 Notification Options  
 

Automatic Email Notifications - Automatic email notifications are essential for keeping callers and agents informed with the 

progress and status of the case. AssistMyTeam Helpdesk offers a whole lot of notification options for different events such as 

when a case is created, changed or resolved, or when an agent is assigned to the case, or when the due date has lapsed etc. 

The template for such a notification email is available for customization as discussed earlier. Automatic emails are sent out 

directly when a relevant event occurs and the whole exercise is transparent to the agents.  

Check the box of email of the corresponding notification that you want to enable and then click 'Save' button.  

 

 

Email Alerts 

Here you can enable or disable automated email notifications. To enable a particular email notification, check the 

corresponding box. 

NOTE: To customize the template of each of the notification as per your requirement, use the Templates Manager. 

 

 

Automated Email Notification Samples 
Here are few samples of automated email notification as send to recipient from AssistMyTeam Helpdesk. 

Email notification to caller when a support case is logged from an email/call 
As soon as a support case is logged with AssistMyTeam Helpdesk, a notification email is sent out automatically to the caller 

(using a customizable template) informing about the detail of the generated case including the case number. 
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Email notification to caller when technicians are assigned to their cases 
Consider a new case which the manager assigns it to an agent. As soon as the case is saved, the helpdesk add-in 

automatically sends out the notification email to caller (using a customizable template) informing about the assignment of 

a new agent. If existing agents are changed, the same notification would be triggered and the caller is notified again. 

 

 

Email notification to caller when a case is closed 
When an agent marked a support case as fixed, it is closed. At the same time, a notification email is sent out automatically 

to the caller (using a customizable template) informing about the closure of the case. 

 

 

Email notification to assigned agents when a case is reopened 
This scenario would happen when the caller replies back to a support case that had been already marked as resolved. 

AssistMyTeam Helpdesk would then automatically reopen the case and sent notification email to the assigned agents.  
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Email notification to assigned agents when the due date is about to lapse 
This is a notification send to the assigned agents when the agents failed to resolve the case within the stipulated due date. 

 

 

Email notification to agents when a case is assigned 
An automatic notification email would be sent out to the assigned agents when cases are assigned. 
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Adding Attachments to automated notification emails 

 

 

 

Attachments to include in case allotment notification - Often most helpdesk policy requires that certain 

documents such as EULA, disclaimer or Service agreements etc., are also send along with the automated email to 

the caller when a ticket is allotted. 

 

NOTE: Such document files should be placed on a network shared folder e.g., \\Server\File so that, AssistMyTeam 

Helpdesk add-ins of all technicians are able to access the files from their systems on the network. 

 

 

Attachments to include in case completion notification - And likewise, you can configure AssistMyTeam Helpdesk 

add-in to include certain documents when sending out the automated email about case closure to the caller. 

NOTE: Such document files should be placed on a network shared folder e.g., \\Server\File so that, AssistMyTeam 

Helpdesk add-ins of all technicians are able to access the files from their systems on the network. 
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Configure Alerts Workflow 
   

  

 

Alert on ‘Due Time’ lapse should be sent to Agents 

When the due date of a case approaches or is about to be lapsed, you can specify how and when AssistMyTeam 

Helpdesk add-in should notify the assigned agents (of the case).  

 

For instance, if you want the add-in to notify the agents only after the due date has lapsed, then choose the first 

option ‘On Lapsed’. 

 

On the other hand, if you want the agents to be warned well before the due date is about to be lapsed, then 

choose the second option ‘When it is about to lapse in’ and specify number of hours before such notifications are 

to be sent to the agents. 

 

Alert on ‘Response Time’ lapse should be sent to Agents 

When the respond by date of a case approaches or is about to be lapsed, you can specify how and when 

AssistMyTeam Helpdesk add-in should notify the assigned agents (of the case).  

 

For instance, if you want the add-in to notify the agents only after the respond by date has lapsed, then choose 

the first option ‘On Lapsed’. 

 

On the other hand, if you want the technicians to be warned well before the respond by date is about to be 

lapsed, then choose the second option ‘When it is about to lapse in’ and specify number of hours before such 

notifications are to be sent to the agents. 

 

Include attachments from the case to automated notification email  

If enabled, the add-in will include copies of the attachments, if present in the case item, into the automated 

notification emails. 

 

Allow Agents to edit the newly generated case (from email) before sending the automated alerts)  

By default, when generating a case from an e-mail (through the 'Convert to Case' button), the add-in assigns a new 

ID and accordingly, the allotment and agent notification e-mails are sent instantly.  

However, if your helpdesk workflow requires that the technicians add more information to the new case, like an 

attachment or caller address etc., before the add-in can send out the automated notifications, you can enable this 
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option. When enabled, the helpdesk add-in would display the newly generated case instantly allowing the agent to 

alter/add information such as custom fields, attachments or assigning it to another agent, for example.  

Only when the technician clicks 'Save' button, the add-in will assign a new ID and send out the notification to the 

caller/assigned technicians. 

 

Don't use default template in replies made from case form 

If enabled, when agent clicks the 'reply to last email' button in the case form and no recent replies from the caller 

exists, the add-in will use a blank template instead of the ‘Email to Caller’ template. 
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4.8 Advanced Options  
 

With the advanced options, managers can control and streamline how agents interact and complete cases in Outlook.   

 

 
Only process incoming emails from existing caller lists 

Check this option to only process support requests coming from callers that already existed in the AssistMyTeam 

Helpdesk callers list. Any emails from outside the caller list are simply ignored by the add-in. For monitored folders and 

mailboxes, emails that are not from the callers list are moved to a subfolder 'Unprocessed Emails'. Please note that, to use 

this feature, technicians would need to have a higher permission (such as Publishing editor or owner) over the monitored 

mailbox or folder. By default, this option is disabled. 

 

You can compile a list of your callers in AssistMyTeam Helpdesk Manager > Callers List. 

 
 

 
Only process incoming emails from domain names listed under companies list 

By default, helpdesk add-in can raise support cases from any emails. However, if your support policy is only confined to 

customers from known or trusted companies or domains, you could configure AssistMyTeam Helpdesk to only process 

helpdesk related activities and workflow from emails sent from admin specified domain names. And emails from outside 

the trusted domains would be skipped. To implement this selective processing policy, the manager needs to define such 

list of trusted domains under AssistMyTeam Helpdesk Manager > Callers List > Company tab. 
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So, when you or other technicians try to generate a new case from an email send from an unlisted domain, AssistMyTeam 

Helpdesk would not process and instead a popup message would be shown that the email sender domain is not trusted. 

 

 
Allow multiple conversion of Outlook items to support cases in a single click 

To increase productivity, this option enables a technician to convert multiple selected Outlook items such as emails, 

appointments or tasks to support request cases in a single-click. Use the 'Convert to case' button to achieve this. By 

default, AssistMyTeam Helpdesk processes a single email to support case, no matter how many emails were selected. 

 

 
Allow multiple cases operation (Delete/Print/Resolved/Create KB) in a single click 

This option enables a technician to batch-process any support case specific operations such as marking as resolved, 

deleting, printing, re-opening etc. on multiple support cases. By default, AssistMyTeam Helpdesk processes a single 

support case when such operation is initiated. 

 

 
Do not send notification to caller if no agent is assigned to the case 

Enable this option so that the add-in skips sending automated notifications to caller if the allotted case has not been 

assigned an agent. 

 

 
Automatically add first time caller to callers list 

If enabled, when a new first-time caller seeks support request (when they send an email to support), the helpdesk add-in 

will automatically add it to the list of callers in helpdesk database, for future use. 

 

 
Automatically add new problem to Problems list 

If enabled, when a new problem category or type (that does not exist in Problems list yet) is entered by the technician in 

the case form in Outlook, the helpdesk add-in will automatically add it to the list of problems in helpdesk database, for 

future use. 

 

 
Allow color coding of case items based on the status of the case 

If enabled, when you set the status of the case or when the add-in does that automatically using the default status values 

set for various events, you will see that the categories column of the case item has color-coded status (which you can 

define for each status under the column 'Color Code' in AssistMyTeam Helpdesk Manager > Problems List > Statuses List). 

 

 
 

 

 
Default language of the user interface (UI) 

AssistMyTeam Helpdesk add-in supports the following languages: English, Español, Norwegian, Danish, Dutch, Deutsch, 

French, Finnish, Swedish, Portuguese. 

 

Choose a language from the drop-down to use with AssistMyTeam Helpdesk add-in in its User Interface (UI). 

 

NOTE: This setting will only take into effect once your restart Outlook. 
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Configuring Outgoing Accounts 
 

  
 

In AssistMyTeam Helpdesk Manager > Advanced Options > Outgoing Accounts tab, you can specify which mailbox account 

would AssistMyTeam Helpdesk add-ins use to send out the automated notification alerts and replies to callers and 

technicians. 

 

 

When you select the first option 'None', AssistMyTeam Helpdesk will use the default/primary mail account that is 

configured on the Outlook profile to send out the alerts and replies. You should use this option if you want each 

technician to send out the auto-alerts and replies from their associated default account. 

 

However, if you want a centralized or single account to use for all outgoing emails and alerts, choose the second 

option 'Use this particular account'. This is ideal if you have a common account (e.g., support@yourdomain.com) 

and you want the replies and auto-alerts received by the caller to appear to come from this common account (in 

the from field of the email) no matter which technician is replying/sending those alerts/emails from their Outlook.  

Note: To work with this feature, the helpdesk manager has to explicitly grant 'Send on behalf' of rights to the 

technicians. You do that from the windows server: Active Directory Users and Computers > Common account > 

Properties > Exchange General > Delivery Options. 

 

 

When both 'Send As' and 'Send Behalf of' are enabled, the add-in will try to use the 'Send As' permission as first 

preference. If that fails, it will fall back to using 'Send behalf of'. 

 

The last option is to configure AssistMyTeam Helpdesk to send out notification emails and responses, using the 

'Original Email recipient mailbox account'. For example, assume you have two mailboxes, Support and Sales. And 

you receive support request email, say email A, to Support mailbox, and email B, to Sales mailbox. When 

AssistMyTeam Helpdesk processes and generates a case from each of these emails (either manually or 

automatically), AssistMyTeam Helpdesk will use the recipient account, for sending out the notification emails.  
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So, when sending notification email to Caller A, AssistMyTeam Helpdesk will send it from Support account. i.e., the 

from: field of the email will have Support address, as the sender. Likewise, when sending notification email to 

Caller B, it will be sent from Sales account. i.e., the from: field of the email will have Sales address. 

NOTE: You and other technicians, still need to have 'Send behalf' permission over the Support and Sales 

mailboxes. Otherwise, you will receive an error response from your Exchange Server, regarding inadequate 

permission to send email from that particular account. 
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KB Settings 
 

 
 

Sometimes, you might have requirements to create KB articles that deals with non-support issues. You can mark such articles 

as ‘Personal’ to differentiate it from other KB articles. In AssistMyTeam Helpdesk Manager > Advanced Options > KB tab, you 

can specify additional options to deal with private KB articles. 

 

 

Do not show private KBs in ‘Reply with KB’ dialog box 

Enable this option to hide private KB articles from appearing in the ‘Reply with KB’ dialog box (to prevent 

technicians from accidentally using private KB articles to reply to emails). 

  

NOTE: ‘Reply with KB’ option button is located under Outlook > Helpdesk toolbar in your Inboxes. 

 

 

 

Do not publish private KBs to Web 

Enable this option to exclude private KB articles from being exported and published. 
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Agents Settings 
 

 
 

 

Enables AssistMyTeam Helpdesk to add/update an appointment into the assigned agent's mailbox calendar when 

the managers assign/change the due date on a support case. Any change in the due date of that case at a later 

stage will be automatically updated to the existing appointment in the mailbox. This appointment is removed 

when the corresponding case is closed. 

These helpdesk due date appointments appear in 

summarized form on the main 'Outlook Today' page 

when the agent starts Outlook. This way, the agent gets 

to know which new cases are being assigned to him/her 

In the default calendar, the due date appointments 

appear as any other appointment. The case number 

and the subject of the assigned case in the appointment subject differentiate it from other personal appointments. 

 

When the due date appointments are about to be overdue, Outlook automatically displays reminders popup to 

the agent. This way, the agent is alerted about the pending cases which need his/her attention.  
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 The details of a due date appointment added from AssistMyTeam Helpdesk to the agent’s mailbox calendar: 

• the case number and case subject are available in the appointment' subject 

• the due date of the case is the same as that of the start time and end time of the appointment 

• The appointment description also informs the technician about the caller, and a summary of the problem  

 

 

Enables AssistMyTeam Helpdesk to add/update a task into the responsible agent's mailbox task folder when the 

managers assign/change the due date on a support case. Any change in the due date of that case at a later stage 

will be automatically updated to the existing task in the mailbox. This task is removed when the corresponding 

case is closed. 

 

Automatically add new Agent to the Agents List 

Enable this option to auto add first time new agent to the Agents List of the helpdesk database. 

 

Enable this option if you want AssistMyTeam Helpdesk to automatically assign the default technician (specified for 

a particular caller in the callers list) to a support case. By default, this option is enabled.  

 

Enable this option if you want AssistMyTeam Helpdesk add-in to automatically assign the current agent to the new 

case generated from an email manually. 

 

Enable this option if you want AssistMyTeam Helpdesk add-in to automatically assign the current agent to the new 

case generated from an email automatically. 
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Others Settings 
 

 
 

 

Helpdesk Service Hours - Enables managers to specify the service days and hours their helpdesk operates. With this 

mechanism, any automatic assignment of response by date or due date to support cases would be dynamically adjusted 

to fall within the service days and hours. By default, service day start from Monday and ends at Saturday. You can choose 

the service starting and ending days as per your helpdesk requirement. 

 

Once a service days and hours are specified, respond by date or due date assignment will take note of the helpdesk 

unavailability accordingly. That is, when ‘due date’ or ‘respond by date’ are enforced on a case automatically, the add-in 

will make sure, the ‘response by date’ or ‘due date’ is always set within the service hours band. So, no longer you or 

other agents would be sent respond by date or due date lapse automated alerts in off hours of the helpdesk. 

 

 

Check which hourly rate to use for calculating the cost of supporting the case in statistics 

Specify which hourly rate to use in statistics in calculating cost - Agent rate, problem rate, or company rate. This is useful 

if the organization use hourly rate to pay agents. 

 

NOTE: To add or modify the hourly rate, refer below 

For Agent rate: AssistMyTeam Helpdesk Manager > Technicians List > Hourly rate 

For Problem rate: AssistMyTeam Helpdesk Manager > Problems List > Categories 

For Company rate: AssistMyTeam Helpdesk Manager > Callers List > Companies 

 

 

Show Duration in reports as 

When you run reports or statistics, you have a choice to display duration fields (such as Open Duration, Resolution 

Duration, Response Duration, Elapsed Duration) in either Days, Hours or Minutes. 
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4.9 Case Options  
 

 

 

Problem Category of newly generated case 

Choose a particular problem category from the drop-down list that will be used as default value for Problem Category 

field on newly raised case. To add new problem category, refer to AssistMyTeam Helpdesk Manager > Problems List > 

Categories tab. 

 
Problem Type of newly generated case 

Choose a particular problem type from the drop-down list that will be used as default value for Problem Type field on 

newly raised case. To add new problem type, refer to AssistMyTeam Helpdesk Manager > Problems List. 

 
Status of newly generated case 

Choose a particular status from the drop-down list that will be used as default value for status field on newly raised case. 

To add new statuses, refer to AssistMyTeam Helpdesk Manager > Statuses List. 

 
Status of Resolved/Completed case 

Choose a particular status from the drop-down list that will be set to a resolved/completed case. 

 
Status of Re-opened case 

Choose a particular status from the drop-down list that will be set to the reopened case. 

 
Status of case on reply send to the caller 

Choose a particular status from the drop-down list that will be set to the case once a reply is successfully send to the 

caller. 

 
Status of case on reply received from the caller 

Choose a particular status from the drop-down list that will be set to the case after a reply is received from the caller. 

 
Status of due date lapsed case 

Choose a particular status from the drop-down list that will be set to the case on due date lapsed. 

 
Status of newly assigned case 

Choose a particular status from the drop-down list that will be set to the case just after assigning to a technician. 

 
Status of respond by date lapsed case 

Choose a particular status from the drop-down list that will be set to the case on respond date lapse. 
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When a problem type is chosen from the drop-down field in the case form, you can configure if the helpdesk add-in will 

also automatically apply the Agents (that are default and associated with the chosen Problem Type) to the case.  

 

You can choose default agents for each problem type under AssistMyTeam Helpdesk Manager > Problems List. 

 

 
When a caller is chosen from the drop-down field in the case form, you can configure if the helpdesk add-in will also 

automatically apply the agents (that are default and associated with the chosen caller) to the case.  

 

You can choose default agents for each caller under AssistMyTeam Helpdesk Manager > Callers List. 
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New Case 

 

 

 

By default, check the 'Disable Notifications to caller' option on newly generated cases 

Sometimes, on specific cases or caller, you may want helpdesk add-in not to send auto notifications on activities or 

events of the case. So instead of disabling a particular auto-alert at the global level, you can choose to disable auto-alerts 

on per case. Enable this option so that by default, notifications are turned off to caller for new cases. 

 

 

 
By default, check the 'Disable Notifications to Agents’ option on newly generated cases 

Likewise, on specific cases, you may want helpdesk add-in not to send auto notifications on activities or events of the 

case. So instead of disabling a particular auto-alert at the global level, you can choose to disable auto-alerts on per case. 

Enable this option so that by default, notifications are turned off to assigned agents for new cases. 
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Automatically assign agent associated with the sender's email domain name to the new case 

If enabled, helpdesk add-in will automatically assign default agent to a case based on the sender's domain address e.g., 

sender@somecompany.com 

 

NOTE: You can add company details under AssistMyTeam Helpdesk Manager > Callers List > Company tab. And add 

somecompany.com in the domain column and also specify default agent for that company. 

 
If a problem type exists in the email subject, automatically assign it and related default values to the new case 

If enabled, the helpdesk add-in will automatically search for the existence of any problem type keyword in the subject of 

emails. If exists, it would auto-assign the default values of the agent, or problem category fields (based on the admin 

enabled fields) to the case that are associated with the particular problem type. 

For example, if the subject of the support request email contains the word ‘iPhone’, the add-in can automatically assign 

the associated default values of ‘iPhone’ Problem Type such as Problem Category ‘Mobiles’ and Agent ‘Abel Conie’ to the 

newly logged case. 

 

 

And assuming a customer sends an email to helpdesk with problem type ’iPhone’ keyword in the subject.  

 

When a case is raised from this email (manually or automatically), the helpdesk add-in will sense the presence of a 

problem type keyword (e.g., iPhone). And it’s intelligent enough to auto assign the default agent associated with this 

problem type. This will in turn trigger a notification alert to the assigned technician as well as to the supervisors (if the 

specific alerts are enabled in AssistMyTeam Helpdesk Manager > Notification Options > General Alerts tab). 

 

mailto:sender@somecompany.com
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Due Date for newly created cases 

Specify how the due date of newly created support cases should be assigned. 

 

a) Assign current Date/Time – Choose this option to set the current date/time (e.g., same as when the case was created). 

 

b) Schedule – Choose this option to schedule ahead it. You need to input the number of hours or days that will be 

scheduled ahead for the due date of the new case. 

 

c) Assign the current or next available Working Hour – Choose this option to dynamically seek the next available working 

hour (as per helpdesk availability e.g., starting and closing hours). 

 

d) None – Choose this option to have empty due date on the new case. 

 

 
Respond by date for newly created cases 

Specify how the respond by date of newly created support cases should be assigned. 

 

a) Assign current Date/Time – Choose this option to set the current date/time (e.g., same as when the case was created) 

 

b) Schedule – Choose this option to schedule ahead it. You need to input the number of hours or days that will be 

scheduled ahead for the due date of the new case. 

 

c) Assign the current or next available Working Hour – Choose this option to dynamically seek the next available working 

hour (as per helpdesk availability e.g., starting and closing hours). 

 

d) None – Choose this option to have empty due date on the new case. 
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Case ID and Prefix Code 
 

 

 

Append Prefix Code in Email Subject 

Enable this option so that the helpdesk add-in will add a prefix code before the case ID (under subject field) of the case or 

to the outgoing emails. You can choose which prefix code to use from one of the following fields: 

• Agent Code – You can define prefix code for each agent under AssistMyTeam Helpdesk Manager > Agents List. 

 

 
 

• Problem Category Code – You can define prefix code for each category under AssistMyTeam Helpdesk Manager 

> Problems List > Categories List tab. 

 
 

• Problem Type Code – You can define prefix code for each problem type under AssistMyTeam Helpdesk Manager 

> Problems List. 
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• Company Code – You can define prefix code for each company under AssistMyTeam Helpdesk Manager > Callers 

List > Company tab. 

 

 
 

• Global Code – You can define one global, fixed prefix code that will be used in all cases and email 

communications within the helpdesk. 

 

 

For instance, you can choose ‘Use Agent Code’ so that the helpdesk add-in can insert the prefix code of the assigned 

agent in the subject of the case and emails.  

 
 

Alternatively, you can also define a global fixed code that would be prefixed in all the cases. By default, adding prefix 

code before the case ID in the subject of the email is disabled. 

What are the benefits? By adding a prefix code to the subject of the case or on outgoing emails, when callers reply back, 

the received emails would contain the same prefix code. And this in turn may aid in quick recognition of the particular 

case, by simply looking at the prefix code.  
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For instance, if the agent code is set as the prefix code, you can easily recognize who is responsible for attending to the 

reply or the case. Moreover, it is easy to differentiate important emails from the less trivial ones. 

 

 
 

 
Placement of Case ID/Prefix code in subject 

Choose if the prefix/code (enclosed in square brackets) is to be placed at the beginning or end of the subject line. By 

default, the prefix code/ID is placed the beginning of the subject. 
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Consolidated Conversation and Emails Threading 
 

Most support cases cannot be closed within a single e-mail and response. Feedback from the caller and suggestions from the 

respective agents often occur over multiple request-response emails. Moreover, different members from the support teams may 

provide resolutions during the course of the request. So, in practical scenario, a support case might have various e-mail versions of 

the resolution steps, making it cumbersome to get a complete picture of responses and resolution. 

With the conversation threading feature, AssistMyTeam Helpdesk captures the complete course of the conversation chronologically, 

from all email communications received or sent (including those automated notifications sent to caller and agents in due course). 

The end result is a consolidated view where all the responses to a support request are collated together. Redundant and repeated 

conversations are filtered out to present only the relevant communications. This eases the task of the helpdesk and minimizes 

repeating what has already been done, while keeping support team members to stay on the track. Another advantage is it allows the 

agent to quickly glimpse through the thread and get a complete overview on the responses in chronological order and resolution 

applied to the particular support request, something which is hard to extract from viewing multiple email responses. 

 

 

Choose if new conversation to the case is to be added on top or below of existing consolidated conversations. 

 
Add header entry in the consolidated conversation for automated notification sent 

Enable this option to embed a snippet entry of the automated notification or alert sent to the caller or agents by the 

helpdesk add-in. 
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Add whole alert content into the conversation 

Enabling this would insert the whole content of the automatic alert email (that was triggered and send to the caller or 

agents from the helpdesk). 

 

 

 
Transfer attachments from email reply to case item 

When processing incoming replies (that contains attachments) from caller, enable this option so that the helpdesk add-in 

will also automatically add these attachments from email to the case item. 
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Optionally, you can enable the option ‘Add entries of new attachments in the conversation’, so that a new snippet entry 

on the attachment names (which were added to the case) are included to the conversation. 

 

 
Add notes to consolidated conversation 

Enabling this would add a copy of the private note to the case conversation as well.  
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Customize the background color of the conversation headers 

 

You can set your own backcolor of different conversation headers that are embedded into the consolidated conversation 

section. This could be helpful to distinguish between multiple types of conversation such as those replied by the caller, or 

those responses send by the agent to the callers, or those conversations that were forwarded or added as private notes 

by other agents or managers etc. 
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Helpdesk Fields Workflow 

 

 

 

Mandatory fields that are required to be filled out for marking a case as resolved 

Enable this option to set certain helpdesk fields as mandatory to be filled, before the case can be marked resolved or 

complete. And select the fields that are to be made mandatory.  

NOTE: Mandatory fields will be shown in red labels in the case form. 

 
Hide Case form sections/tabs 

Helpdesk manager can choose to hide certain portion of the Outlook case form, such as the Time Spent, Notes section 

etc. if these sections or tabs won’t be used at all. And this setting would affect all agents. For example, below is how 

the case form appears when none of the sections/tabs are hidden. 

 

And below is the case form with ‘Related Cases’ and ‘Time Spent’ tabs are hidden. 

 

 
Limit user from entering their own value in the following drop-down fields 

Check the particular drop-down fields that you only want technicians to be able to choose from the drop-down and 

prevent entering their own. By default, agents can input their own value against the available drop-down list. To 

prevent non-existent value from being tagged to the case for these drop-down fields, check the corresponding field. 
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NOTE: drop-down fields with limitation in case form are greyed out, where ones without limitation are not (white 

back-color) 
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Case Form  

 

 

 

Prompt me if to customize the auto alert for Case Closure 

Enable this option to force the helpdesk add-in to prompt the technicians for confirmation on case closure as well as to 

choose if to send the auto notification to the caller. If yes, the technician can choose to customize the notification (say, if 

further information specific to that ticket or caller are needed to be added before it is finally sent). 

 

 
 

 
Prompt to add Time Spent when closing the case form 

Enable this option to force the helpdesk add-in to prompt the technician to add their time spent data to the case when 

the form window is closed. 
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When replying to an email from case form, always use the case subject in the reply 

When enabled, the add-in will use the subject of the case in the email reply made to the caller. 

 

 
Automatically update caller information from the case form to the Callers List 

 

If enabled, the helpdesk add-in will track the changes in the caller information in the cases and if required, will make the 

necessary update back to the AssistMyTeam Helpdesk Manager > Callers List if any of the caller information was changed 

or added in the case. 

 

For example, when a caller seeks support request the first time, the helpdesk may only have the caller email and name in 

the callers list database.  

However, after iteration of communication or calls, if the caller information was updated to the case to include say, 

phone number, mobile number, address, company etc., the helpdesk add-in will automatically track and update the 

caller information back to the Callers list database for future use. 
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Other Case Options 

 

 

 

Include CC users in the notification email sent to the caller when a case is generated from an email 

If enabled, when a support case is first generated from an email, helpdesk add-in will send out the case allotment 

notification email to the caller, as well as to the recipients specified in the CC field of the original email. The benefit is to 

allow anyone (on the CC line) to respond to the ticket thread without creating a new ticket. 

 
Automatically view the case that was re-opened in its inspector window 

Enable this option to force helpdesk add-in to display the case in its window when it is re-opened from the completed 

state. This is applicable and handy if you had re-opened the cases from the dashboard panel located in the Outlook 

explorer window. 

 

 
 

 
Don't reopen a closed case automatically 

There may be situations where the caller just replied to say, thank you for the support. But that may trigger a reopening 

of the case with unnecessary overhead. Enable this option to prevent the helpdesk add-in from automatically re-opening 

a case from its completed state when a response from the caller is received by the helpdesk after the completion of the 

case. This will also prevent the add-in from adding redundant and irrelevant information to the closed case. 

NOTE: If enabled, closed cases won’t reopen automatically when a customer sends a reply after the case is closed. This 

way it is very easy to miss the reply of the customer because the case stays in closed issues. Technicians would have to 

manually re-open the case (if they deem fit) after analyzing the response from the caller i.e., if the caller just replied to 

say, ‘Thank you for the support’, you can ignore the escalation. 
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Use ‘Print’ template when exporting case to file 

By default, the add-in will export the case to file using the Outlook message layout. If you want to customize the content 

and formatting of the case before printing, you can enable this option so that add-in uses the ‘Print’ template available 

under Helpdesk Manager > Templates Manager. 

 

You can control what case data are included in the files by customizing the 'Print' template. For example, place the 

variable 'CASE_BODY' in the Print template such that the exported file (e.g., pdf) contains all the consolidated 

conversations (body) from the case item including inline images. 

 

 
Moved Processed emails to subfolder ‘Processed Emails’ 

By default, when a case is raised from an email or when a reply is added and updated to the case, the email is kept intact 

in its original folder location. But if you want such processed emails to be moved to another folder location, enable this 

option. Doing so, would move the emails to a subfolder ‘Processed Emails’ just under the parent folder. 

 
Open Support Case form automatically when it is generated from other Outlook items - Enable this option to 

display/open the inspector window of the support case just created. This is only applicable when the case is generated 

manually from an email or other Outlook item. 

 
Open knowledge base form automatically when it is generated from other Outlook items - Enable this option to 

display/open the inspector window of the knowledge base just created. 

 
Color coding for Case when priority is set 

 

You can choose a color for each priority - high, normal or low. And this will be reflected in the dashboard panel listing of 

the cases. 
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It will also show up in the case form as well. 
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5. Helpdesk Summary Reports  
Helpdesk summary reports play a vital role in keeping informed managers about recent cases - that were created, worked, 

overdue or resolved. AssistMyTeam Helpdesk provides an inbuilt tool that generates reports on support cases based on a 

specified interval such as today, this week, this month, last month etc. Any fields can be selected for inclusion into the reports 

and can be saved as to file or printed for sharing and easy distribution. 

 

There are four report view modes - List, HTML, HTML Editable and Grid. Noticed that this report tool also uses the same sets 

of search filters discussed in the last section. 

 

 
 

Each case in the search result is color coded to reflect the current status of the case. You can easily recognize which cases 

require the attention or review, and plan actions accordingly. 
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Time Period: Choose a time period from the followings under which the search will be confined: 

Any, Today, Yesterday, Tomorrow, This week, Last Week, Next Week, This Month, Last Month, Next Month, This 

Year, Last Year, Date Range, On 

 

The option 'Date Range…' allows for user selection of start and end date. 

 
 

 

 
 

Report Type: Choose a report type from the predefined ones below: 

Any, Cases Created, Cases Resolved, Cases Ongoing, Cases Worked, Cases Due, Cases Response Date, Cases 

unassigned, Cases lapsed - Due Time, Cases lapsed - Response Time, Cases with no Due Date, Cases with no 

Response Date, Cases with no Caller 

 

 
Search By: Further refine the search by filtering through keywords or using one of the following helpdesk fields: 

Status, Problem, Service level, Caller, Company, Priority, Origin or Author. 

 

 
Group By: You can choose to group the cases either with:  Technicians, Status, Problem Category, Problem Type, 

Service level, Caller, Company, Priority, Origin or Author. 

 

 
Fields: For finer control over the output of 

report, you can choose which fields (including 

custom fields and calculated fields) are to be 

included in the report.  

You can sort the items by clicking at the column 

headers, as well as also re-arrange the columns 

in the list view according to certain sequence of 

your choice, and even set the width of the 

columns. These formatting from the List view 

panel will be inherited on other tabs - HTML, 

editable HTML and Grids. 

The tool will remember your choice in 

subsequent runs. You can re-arrange the 

columns by drag-and-drop to get the kind of 

view you want. And the display order of the 

columns will be retained in subsequent 

sessions. 

 

 
 

Some useful calculated fields that you can include in the report: 

• Raise Duration - interval between when the support request (email or phone call) was received and when 

the case was raised. 
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• Response Duration - interval between when the support request was received (email or phone call) and 

when the first response was made to the caller (by a technician) 

• Open Duration - interval between when the case was raised and the current time. 

• Resolution Duration - interval between when the case was raised and when it was closed/completed. 

• Breach Duration - interval between when the case was due and when it was actually closed/completed. 

 

 
Scope: Choose if to confine the search to your assigned cases only or include all cases. 

 

 
Print the current report - When you click ‘Print’, you would be presented with the print dialog (similar to one used 

by Internet Explorer browser). Within that dialog, you would be able to customize the print settings. Note that, as 

there are multiple report modes (namely, list, HTML, Grid), the printed report will be sourced from the current 

mode (tab) that you are in. 

 

 
Save the current report to file – Once you get the look and feel of your report, you can then export the report to 

one of the many popular document formats supported such as Microsoft Excel sheets, Word documents, Adobe 

PDF, Rich Text or web page etc. 

 

 

 
List report view mode – This act like a template to the other three report modes. For finer control over the output 

of report, you can choose which fields (including custom fields) are to be included in the report. You can sort the 

cases by clicking at the column headers, as well as also re-arrange the columns in the list view according to certain 

sequence of your choice, and even set the width of the columns. These formatting from the List view panel will be 

inherited on other tabs - HTML, editable HTML and Grids.  

 

 
 

 
HTML report view mode – This report view presents the cases in web HTML format with color coding, group, and 

summary information retained. You can export this report to .htm format for your further use. 
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HTML Editable report view mode – This report view is exactly the same as the previous HTML mode, but with the 

flexibility to edit the HTML content in a WYSIWYG editor. For instance, you can customize the font, add image, 

change the color, layout or add any further information you require so that you can compile your own report. 

 

 
 

 
The Grid report view mode – This presents the cases in excel spreadsheet like format with rows and columns, 

preserving color codes, summarized information etc. You can also re-edit and tweak the report. You can also copy 

data from this grid to Microsoft Excel or vice versa. And you can of course export the report as Excel spreadsheet 

file (in XLXS, XLS format). 



 

 

 Back to TOC 

P
ag

e6
8 
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6. Helpdesk OLAP Statistics and Reporting 
 

With the integrated Online Line Analytical Processing (OLAP) tool, helpdesk managers can analyze the support request data in 

multidimensional view and extract mission critical information and intelligence that will enable better decision- in your 

helpdesk and organization. The tool supports the ability to explore large complex data sets and allows displaying in grids, 

charts and graphs and support most common operations such as pivoting, drill down/slice and dice, filtering etc. With such 

arrays of information, the organization can reengineer their help desk processes, reinforce resources and forecast problem 

areas and exploit all these factors for competitive advantage. 

 

Why OLAP? Real strength of OLAP is its ability to examine and view data in ways not ordinarily possible. By allowing varying 

levels of granularity during data inspection and visualization a lot of information can be revealed that would otherwise be 

hard to attain. Given that most business models are constrained by more than three dimensions, it is hard to fully evaluate a 

business without the ability to inspect each dimension in detail while preserving context eliminating all guesswork. OLAP is 

perfectly suited for this purpose. Now it’s easier than ever to spot new trends and discover unknown problems in your data 

flow. The statistical tool will help you gain an insight into your data and make new discoveries. Comes with various inbuilt 

reports specific to AssistMyTeam Helpdesk Cases. 

 

Reporting made easier - The statistical tool's simplistic point-and-click interface will ensure managers easily achieve the high-

level views of information they require. Additionally, the OLAP client makes creating reports destined for different 

management levels a simple task - eliminating managers' dependence on IT personnel. By unifying data analysis needs on a 

single platform, it provides an unparalleled array of reporting tools for web portals, intranet applications, websites, and other 

data-rich applications. 

 

Printing capabilities - you can print your report to share it with others using the built-in Print Preview window. You can tune 

your page/printer settings before printing. Also, if you feel like sharing the report through the net or by email you can easy 

export it to a wide range of formats including PDF, XLS, CSV, JPG, etc. 

 

Copy to Clipboard - Select any data range in Chart/Grid and copy to clipboard. Then you’ll be able to paste it in an Office 

program for further analysis. You can also paste the chart like a picture to illustrate your investigations. This greatly simplifies 

the task of creating detailed, data-rich documents. 

 

Save Reports in file - At any stage managers/technicians can save the report and distribute it to another person for analysis by 

network or email, so when the recipient gets the file, he or she can open it and see the same OLAP slice. 

 

Launching the statistics tool: 

 

Go to Outlook > File > AssistMyTeam 

Helpdesk Manager tab, and click 

‘Statistics’ button. 

 

 
 

 

You can choose what type of OLAP statistics on helpdesk data you would like to see and report on. You can specify if the 

statistics would be confined to ongoing cases or resolved cases or on both. You can further have the choice to include 
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archived old cases that were moved to another exchange folder or PST file. 

 

 
 

There are two parts of OLAP Statistics 

 

 

General OLAP 

Choose this OLAP to run statistics on cases with all helpdesk parameters and fields except for time spent by 

technicians on cases. 

 

 

Time Spent OLAP 

Choose this OLAP to run statistics on time spent entries by technicians on cases. 

 

 

 

  



 

 

 Back to TOC 

P
ag

e7
1 

6.1 The User Interface 

 
The statistical tool presents an easy-to-use interface for operating an OLAP-slice. The basic data is displayed in the Working 

area. The environment tools for managing the content and characteristics of the slice are placed on the pivot panels. You can 

set the panels' layout the way you like. To drag a panel to a different location, you need to capture and drag its header with 

the mouse. At that, all the possible locations, where it can be dropped to, will be highlighted. You can detach a panel from the 

component; it will be displayed as a float window. 

 

 
 

Instrumental panels can be: 

• Attached to any side of the component;  

• Placed into any existing panel;  

• Displayed as bookmarks on any panel;  

• Set as auto-hidden panels;  

• Used as float windows. 

You can change the view of the slice by relocating measures and hierarchies within the environment panel. When you start 

dragging an element, all the possible locations, where it can be dropped to, will be highlighted. Most elements have context 

menus that duplicate the mouse actions and provide additional control functions for managing the slices' view. 

 

 

The File menu 

The file menu consists of the following commands: 
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a) Open Offline Cube from file - While generating a live cube from Outlook always provides the advantage of 

analyzing live data, often, you might be away or disconnected from the network. 
 
In such scenario, you have the option of connecting to an offline cube, which was previously generated and 
saved to your local folder using this utility. An offline cube file has the extension - .offlinecube and can be 
either in compressed or uncompressed format. An offline cube gives the same functionality as that of a live 
cube (which is generated from the Outlook data at real time), except that the data in the offline cube is only 
current to the time the cube was saved to file. This provides the flexibility to continue analyzing the cube 
and writing reports etc, while you are on the move. 
 

b) Open a Predefined View - Pre-defined reports are available under Cases, Callers, Date/Time, Problems, and 
Technicians nodes. Clicking one of child node report loads the statistical analysis of that report, the 
resultant of which will be displayed in the Grid or Chart (depending on the current active view). 
 

 
 

c) Load report file from Favorite – You can customize or create your own views and save them to the favorite. 
Once saved, your views would be saved under the ‘C:\Users\USERNAME\Documents\AssistMyTeam 
Helpdesk Reports\Views’ folder (in windows Vista and 7). For windows XP, it should under My Documents. 
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When you open the favorite from this menu, you can choose to load your saved view. 
 

 
 

d) Open report view from file - Once a particular snapshot of the statistics is achieved, you may want to save it 
for future reference or share it among your team members. A report view is the current state of the 
statistics in the Grid/Chart working area, with specific member fields on the pivot panels (Rows and Column 
areas) and measure fields in the values area. It has a file extension ‘.olapreport’. 
 

 
 

e) Save report view to favorite – You can save the current view of the statistics (grid or chart) to the favorite, 
by specifying a name of the view. 
 

 
 

f) Save report view as - If you want to share a report view with others, you can simply save the current report 
(state of the statistics along with the pivot details) to a file folder of your choice - could be a network folder 
also. 
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g) Save to offline Cube – Once you have loaded a live cube from the cases, you have the option to save the 
entire cube data to a file (with the extension - .offlinecube) for offline use, when you are disconnected from 
the network. Offline cube can be saved in compressed or uncompressed format, the former option will 
enable you to reduce the file size considerably. 
 

h) Same as e. (above) 
 

i) Close the cube - This option closes the cube from the OLAP Statistics and free up the memory for loading 
another cube. 
 

 

View Menu 

Contains actions that you can perform on the current report view. 

 
 

a) Reset Chart/Grid - Empty all the member fields from the pivot as well as the data from the working area of the 
chart/grid. This is useful if you want to start over on a new report view. 
 

b) Synchronize Chart/Grid - This option allows you to reflect the state of the statistics between the Grid and the 
chart. It is particularly useful, for example, when you have built up a grid with aggregated data, but want a more 
visual representation of the statistics in form of graphs and bars. Also note that, the synchronization will be 
done to the other part (grid or chart) based on the current interface.  
 
For example, if you are in the grid view, and if you pressed ‘Synchronize Chart/Grid’ it would read the state of the 
Grid view and impart the same state (same members and measures) to the Chart view and vice versa. Each of 
the Grid and Chart view can be worked independently as long as you don’t press this synchronize option. 
 

 

OLAP Grid panel 

The OLAP Grid control comprises of a multi-dimensional table with expandable nodes. These nodes group and 

display data according to the hierarchies used to define the measures and dimensions upon which the underlying 

data has been organized. A unique feature of control allows for building the OLAP-reports of the exceptional level 

of complexity. In tandem with the OLAP Chart, the OLAP Grid provides an ideal means of clearly conveying data 

to the user. 

 

 

OLAP Chart panel 

While OLAP Grid allows working with numbers, the OLAP Chart allows representing the project data graphically. 

This gives managers and members a unique opportunity to analyze their project data visually, dealing with charts 
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rather than numbers, which is much easier to perceive. 

 

 
 

 

Cube structure panel 

The panel contains the Cube structure - measures and hierarchies as a tree. The measures are grouped in the set, 

displayed in a branch. Rest of the tree nodes are the dimensions that contain hierarchies. 

 

 

 - Measure 

 - Dimension 

 - Attribute hierarchy 

 - Multilevel hierarchy 

 

To select a measure for display you need to drag-n-drop it to 

the Measures panel or the data area.  

 

To select a hierarchy for display – drag-n-drop it to the 

hierarchy area or the pivot panel (rows or columns area). 

 

• Measures are grouped in the Measures category. 
• Hierarchies are sorted into folders - dimensions. If there's 

only one dimension in a hierarchy, it will be displayed in the 
tree root. 

 

Both hierarchies and measures have their own menus. Right click will call the context menu that gives you an 

option to place the element where you like. You can also filter the selected element (see Filtering hierarchies and 

measures) or place it to the selected panel. 

 

 

Pivoting panels 

A pivot table lets user design the report online by dragging and dropping measures, dimensions and levels into 

the pivoting panels. Note that the column panel may contain no more than one (!) measure. Panel elements can 

be dragged with the mouse to other panels. To filter elements, press the Filter button (see Pivot panel view) or 

use the appropriate items from the context menu. 
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Measure panel 

Measure panel consists of groups of measures that make up the charts' vertical axes (see Measure panel 

components). Each group of measures corresponds to a set of charts in the data area. Groups of measures are 

situated in the main part of the panel. 

 

 
 

You can drag measures from one group to another, or extract measures from groups to delete them. To create a 

new group, you need to drag a measure to a place on the panel not occupied by another group or to the <drop an 

item to create a new group> panel. 

 

Clicking a mouse button on measures will call the context menu. From here, you can move a measure to one of 

the pivot panels or to the modifiers axis, or assign a measure filter. Also, you can assign the marker type of a 

chart point and its color. 

 

 

Filter panel 

This statistical tool allows for easy selection on what data you want to see and what you don’t. You can apply 

powerful filters to anything including hierarchy members, and measure values, thus leaving out the unimportant 

data. You can sort the data to see, for example, the top 10 values and then you can gather the rest of the values 

into a single group, so you only have what you really need. 
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The filtered elements (hierarchies and measures) 

are automatically transferred to the Filter panel. 

To assign a filter, you have to move an element 

to the Filter panel. If the element hasn't been 

filtered the appropriate visual filter editor will be 

shown, similar to the one on the right: 

 

 
 

 In the Filter panel, you can call the Filtered Element Editor individually for each element.  

 
 

 

Working Area 

The OLAP-slice data is displayed in working area. In its upper part there is a menu for the quick access to the 

frequently used commands². The rest is occupied by the current OLAP-slice and consists of the following parts - 

Cube Axis headers, Cube Axes, Data Axes, Data Axis headers, Chart Panes. 

 

You can change the view of the slice by relocating measures and hierarchies within the environment panel. When 

you start dragging an element, all the possible locations, where it can be dropped to, will be highlighted. Most 

elements have context menus that duplicate the mouse actions and provide additional control functions for 

managing the slices' view. 

 

Grid working area 

 
 

 

Chart working area 
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6.2 Working with the OLAP grid  
 

The OLAP Grid view is comprised of a multi-dimensional table with expandable nodes. These nodes group and display data 

according to the hierarchies used to define the measures and dimensions upon which the underlying data has been organized. 

In tandem with the OLAP Chart view, the OLAP Grid view provides an ideal means of clearly conveying data to the user. It is 

highly navigable and quickly provides detailed information to the user. The speed with which data recall occurs and the strong 

formatting the grid enforces ensure data is always presentable and easily understandable. Consequently, OLAP Grid views can 

easily be ported to spreadsheet applications for report compilation purposes.  

 

Additionally, the OLAP Grid view allows users to effortlessly add and remove categories, filter and sort categories, and drill up 

or drill down on data using powerful built-in menus. One of the greatest benefits this affords is that it allows users to explore, 

navigate and refine data until the desired snapshot is achieved. Once in place this snapshot can then be reflected in a 

complementary chart. This is possible as OLAP operations in Grid view can be synchronized with Chart view. These two data 

views can then be deployed side-by-side or on top of one another. 

 

 Unicode support.  
 Simultaneous display of several different measures in the Grid.  
 Simultaneous drilling down based on different parameters: up to the nearest child, up to the next level, up to the next 

hierarchy.  
 Saving and restoring the current OLAP-slice.  
 Hierarchy members grouping (including multilevel and parent-child hierarchies).  
 Separate sorting on different hierarchy levels. Possibility to override any sorting method.  
 Ascending or descending sorting based on the cell values in any column of the Grid.  
 Filtering of hierarchy members with or without applying these filters to the OLAP calculations.  
 Auto filtering of the hierarchy members depending on their values in the Grid. Major/minor members selection, either 

based on their rank or on the Pareto principle.  
 Replacing hierarchy members by drag-n-dropping them within the Grid.  
 Auto sizing of cells depending on their contents.  
 Flexible export to MS Excel, HTML, GIF, JPG, PNG, BMP, CSV, TXT, PDF formats. 

 

Operating the OLAP-slice 

The OLAP-slice data are displayed in a table, whose appearance may be amended to some extent. For operating the current 

OLAP-slice there are the following functions available: 

1. Navigation 
2. Selecting and copying data 
3. Drilling, sorting and moving hierarchy members 
4. Operating context menus 
5. Filtering data 
6. Editing data 
7. Setting the column width 

  

1. Navigation - You can easily navigate the data using the keyboard: 

Button  Action 

Home  Move to the first cell of the row 

End  Move to the last cell of the row 

PageUp  Move one page up 

PageDown  Move one page down 

Ctrl+Home  Move to the top left cell 

Ctlr+End  Move to the bottom right cell 

 

Using the mouse, you can scroll the table up and down. 

Mouse Action Component Action 

Scrolling the mouse wheel Vertical scrolling of the table 

Scrolling the mouse wheel with the Shift button held 

down 

Horizontal scrolling of the table 
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2. Selecting and copying data - The data area in the component can be selected like everything else in Windows: 

• Select all the cells pressing Ctrl+A;  
• Capture the area with the mouse;  
• Change the boundaries of the selected area with direction buttons, holding down the Shift button.  

You can copy the data from the selected area to the clipboard by pressing Ctrl+C. If there’s no selection, pressing these buttons will 
copy the whole OLAP-slice to the clipboard. 
 

3. Drilling, sorting and moving hierarchy members - To 
perform the drilling of the hierarchy members press 
buttons on the Grid cells. If there’s only one drilling 
button in a cell, then, instead of pressing it, you can 
double-click the cell itself. By default, the drilling 
buttons are shown only in the cells under mouse. To see 
all the buttons, press the Ctrl button. The last cells in 
the column area of the hierarchy members allow 
showing the sorting direction. A pointer that indicates 
the descending order of data illustrates it. You can 
manage the sorting modes by single clicking on the cells 
of the specified area: they are changed cyclically 
[descending sorting] -> [ascending sorting] -> [no 
sorting]. 

 

 

4. Operating context menus -The context menu, 
called by right clicking a table cell, partly duplicates 

the OLAP-slice control functions. 

 
 

 

 

 

 

 

Hierarchy levels' menu 

The view of context menu of the hierarchy levels' area. There is a list of commands available in the context menu of the hierarchy 
levels’ area: 

Command Function 
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Show totals first Show the aggregated cells before all the rest 

Show totals last Show the aggregated cells after all the rest 

Don’t show totals Do not show the aggregated cells 

Default sorting Range hierarchy members by default 

Sort ascending Range the hierarchy members by values from the bottom to the 

top 

Sort descending Range the hierarchy members by values from the top to the 

bottom 

Aggregate all hierarchy 

members 

Aggregate all the hierarchy members (including hidden) 

Aggregate visible members only Aggregate the visible hierarchy members only 

Drill all down\ to the next 

hierarchy 

Drill all down to the next hierarchy 

Drill all down\ to the next level Drill all down to the next level 

Drill all down\ to the same-level 

children 

Drill all down to the same-level children 

Drill all up Collapse all the elements of this level 

Clear filter Remove any applied filters 

Filter on captions Set the filter for measures 

Show empty cells Show the cells with no aggregated values 

Create new group … Create a new group. It will appear at the first level of the 

hierarchy 

Copy selection Copy the selected area to clipboard 

Conditional formatting Show the Conditional formatting menu 

 

 

Hierarchy members' menu 

 
The view of the context menu of the hierarchy members' area 

 

Command Function 

Drill down to the next 

hierarchy 

Open the node up to the next hierarchy in the current area, ignoring 

all the lower levels of the current hierarchy 

Hide this member Hide the member 

Hide all members except 

this 

Hide all the members of the hierarchy, except the selected one 

Hide all members above 

this 

Hide all the members of the hierarchy above the selected one 
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Hide all members below 

this 

Hide all the members of the hierarchy below the selected one 

Show only the top Show the top elements of the level. Their number is specified in the 

sub-menu. If you specify a percent value there, then the picking of 

members will be such that their total value does not exceed the one, 

specified in the sub-menu. 

You can choose a threshold value from those offered in the 

appropriate menu item or set your own one, selecting Other from the 

menu. 

Show only the bottom Show the bottom elements of the level. Their number is specified in 

the sub-menu. If you specify a percent value there, then the picking of 

members will be such that their total value does not exceed the one, 

specified in the sub-menu. 

You can choose a threshold value from those offered in the 

appropriate menu item or set your own one, selecting Other from the 

menu. 

Filter on captions Set the filter for measures 

Create new group.. Create a new group on the current level 

Copy selection Copy the selected area to clipboard 

Conditional formatting Show the Conditional formatting menu 

 

The menu for groups of hierarchy members 

 
The context menu that appears above the group cell. 

 

 

 

 

Command Function 

Hide this member Hide the selected member 

Hide all members except this Hide all the hierarchy members except the selected one 

Hide all members above this Hide all the hierarchy members above the selected one 

Hide all members below this Hide all the hierarchy members below the selected one 

Show only the top Show the top elements of the level. Their number is specified 

in the sub-menu. If you specify a percent value there, then the 

picking of members will be such that their total value does not 

exceed the one, specified in the sub-menu. 

You can choose a threshold value from those offered in the 
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appropriate menu item or set your own one, selecting Other 

from the menu. 

Show only the bottom Show the bottom elements of the level. Their number is 

specified in the sub-menu. If you specify a percent value there, 

then the picking of members will be such that their total value 

does not exceed the one, specified in the sub-menu. 

You can choose a threshold value from those offered in the 

appropriate menu item or set your own one, selecting Other 

from the menu. 

Filter on captions Set the filter for measures 

Create new group Create a new group 

Delete this group Delete the selected group 

Clear this group Clear the selected group 

Rename this group Rename the selected group 

Copy selection Copy the selected area to clipboard 

Conditional formatting Show conditional formatting menu 

 

 

Measure values' menu 

 

 The context menu that appears above the group cell: 

Command Function 

Sort ascending  Range the cells in the column by values from the 

bottom to the top  

Sort descending  Range the cells in the column by values from the top 

to the bottom  

No sorting  Remove any sorting  

Filter on captions  Set the filter for measures 

Hide these measures Hide the selected measure 

Show as Specify the display mode of the current measure in 

the Grid: 

default 

percent aggregated value in the row 

percent parent element of the row 

percent parent element of the column 

percent total aggregated value 

Copy selection Copy the selected area to clipboard 

Conditional formatting Show conditional formatting menu 

 

5. Filtering data - The filtered elements (hierarchies or measures) are automatically placed on the filters' panel. To start filtering, 
move the element to the filters' panel. In case the element has not been filtered, the appropriate editor will launch (the Hierarchy 
Editor for hierarchies and the Measure Filter Editor for measures). In the filters' panel, you can launch an editor for each element 
independently. 
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The buttons for launching the editor ( ) are placed on the 
panels in the Hierarchy levels’ area. If the button looks like 
this ( ), it means the hierarchy had hidden members inside. 

Pressing the button starts the Hierarchy editor. 

 

 
 
6. Setting the columns' width - You can change the width of columns in the data display area by dragging the right boundary with 
the mouse. If possible, these changes will be saved during other operations with the table (like drilling, sorting, etc.) To return to the 
original width, double click the right boundary of the column where it is visible. In case there were such changes in the table that 
saving the assigned width of the columns was impossible (for example, if as a result of the Collapse drilling, the column with the 
assigned width has disappeared), it will be set automatically. Unfortunately, if you operate a big table, calculating the columns’ 
width takes up too much time. That is why if there are more than 10, 000 cells in your table, their width will be set to default, but it 
can be corrected later. 
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6.3 Working with OLAP Chart 
 

While the Grid view allows working with numbers, chart view allows representing your helpdesk data graphically. This gives 

you and other managers a unique opportunity to analyze helpdesk data visually, dealing with charts rather than numbers, 

which is much easier to perceive. Now it’s easier than ever to spot new trends and discover unknown problems in your data 

flow. The statistical tool will help you gain an insight into your data and make new discoveries. 

 

 
 

Tools panel 
This panel houses all the frequently used operations on the OLAP chart - save, export, print and display options. 

Button Function 

 Load the Grid state 

 Save the Grid state 

 Export OLAP-slice data 

 Print OLAP-slice data 

 Preview 

 Undo 

 Redo 

 Switch axes 

 Select the docking panels layout 

 Set the scale of Chart display 

 Select the color palette for measures 

 

 

Modifier panel 
Modificators are easy and powerful means of data representation. You can choose your data be shown in different colors, using 
different shapes and sizes, so that you can easily distinguish them in a single graph. You can simply place a dimension or a measure 
on a modificator’s pane and get the graph showing different values in a different manner. 
 
For example, you might place the "Problem Category" dimension on Color pane and get the Chart showing problem categories in 
different colors. Or you can place the "Cost" measure on Color pane to highlight the top rates of supporting the service requests. The 
same can be done for Shape and Size so that you can make your data perfectly distinguished. 
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The layout of panels and hierarchies on the Modifier panel allows you to change the appearance of the displayed slice. When an 
element is placed to the modifier panel (except for Details), its legend will contain the display parameters. If you modify the color 
and shape of an element, the appropriate parameters can be amended. 
 

Modifier The changes made upon placing a Chart element to the modifier area of... 

a measure a hierarchy 

 

  

The color of the Chart elements will be 

chosen from the standard set of gradient 

colors  

 

Hierarchy members will be painted with 

the colors from the current palette 

Color The elements with the minimal value will 

be painted with the first of the gradient 

colors, and the elements with the 

maximal value - with the last one 

 

N/A 

Size Depending on the value of the measure 

the size of the Chart points will vary 

from the minimal to the maximal. 

 

Hierarchy members will differ in size 

Shape Forbidden Hierarchy members will differ in shape. 

If the number of hierarchy members will 

exceed the number of available shapes, 

some of them will be used more than 

once 

Details Forbidden The panels will display series for all 

hierarchy members 

 
If a measure is placed on the Color pane, its values range is mapped to the given colors range so that it’s tremendously easy to spot 
the top/low values. If you select the discrete gradient type, you'll be able to set threshold values for filling the Chart elements. While 
the continuous gradient will let you evaluate the trend as a whole. To select the gradient type and tune its content, turn to the 
legend panel. 
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The Legend panel 
The panel contains descriptions of the modified elements. 
The value, shape and color of a legend element can be 
edited. 

Setting the Color legend 
To select a color, simply double-click the appropriate element 
and choose a color from the pop-up editor. 

 

 

Setting the Gradient legend 
To edit the gradient, double-click the element and tune the settings in the 
editor. In the Gradient Editor there are: 

• a set of pre-made gradients;  
• selecting gradient option (continuous or discrete);  
• creating a gradient with a set number of intermediate colors option;  
• setting threshold in per cent and measure values option;  

 

Selecting threshold color option. 

 

 

 

 

Setting the Shape legend 
The shape selection is made through the context menu. This 
option is available only for points or lines Charts. If the 
number of hierarchy members exceeds the number of 
available shapes, they will be repeated. 
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Chart Panes 
The bulk of the OLAP-slice data are placed into cells with Charts. Each measure group has its own set of panes.  
 

 
Measure groups with corresponding Charts in the working area 

  

Chart Type 

In the upper left part of each Chart, there will appear a 
context menu for selecting its type. There are six (6) charts 
that you can use, namely, Point Chart, Histogram, Point 
Shape Selection, Lines, Curved lines and Step lines. By default, 
the Histogram is used. 

 

The size of Charts can be changed to some extent. To expand 
a Chart along either one of the axes, you need to capture its 
boundary with the mouse and drag it. You can change the 
size along both axes (and return to default) through the tool 
menu in the upper part of the working area. 

 
Chart type menu 

 

  

Hot keys for changing the scale 

Ctrl+* Reset Scale to 1:1 

Ctrl+Num+ Zoom In 

Ctrl+Num- Zoom Out 

 
Navigation 
If the content of the Grid exceeds the client area, the scroll bars will appear. You can scroll down the data using the mouse wheel. To 

scroll the Grid in the vertical direction, turn the mouse wheel, while holding Shift. 

 
Selecting Data 

You can select Chart points with the standard Windows' method. Holding down the Ctrl button, you can add selected points, 

holding down the Shift button, you can select the horizontal range. You can filter the Grid's points while selecting. In that 

case, the corresponding hierarchy members will be filtered automatically. 

Selecting and filtering parts of Charts 

a. Selecting some of the Chart points 
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b. Selecting the Filter command 

 

 

c. The result 

 

Note: When moving the mouse cursor over a data axis, you are able to select a continuous range of members (if the axis is 
composed of them) or a range of values in Charts. 

 
 

Filtering hierarchies 

In case you need to collect data not from the whole Grid, but just from a part of it, the component has a few functions at your 
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disposal: they let you select or remove elements from the slice. Also, there is a standard option of exporting data into a 

number of formats and printing out the content of OLAP-slices. The simplest way of selecting data is through the context 

menu. When you click a hierarchy member on the Cube axis, there is a set of commands for quick operations with members: 

• Hide this member  
• Hide all members except this  
• Hide all members above this  
• Hide all members below this  

Filter on hierarchy level 
The Filter area of the Editor becomes visible only in case if filtering by hierarchy levels is available. To apply a filter to hierarchy 
members, you need to select a hierarchy level (if there's more than one) and assign the Filter condition in the Filter menu. In the 
same menu, there's a command to clear filter. 
 
Filtering hierarchy members 
If the search field is not empty, the "Find" command will make the component perform a search for hierarchy members, whose 
levels contain the specified string. You can narrow the search results by checking the "Exact matching" box.  
 

Filtering a single member of a hierarchy 
By default, the Editor is able to select any number of hierarchy members. To switch to the single-select mode, uncheck the 
"Multiselect" box. In that case, only one the hierarchy member with all its parents and members will be selected.  
 

 
  

Filtering measures 

There is a number of available parameters for filtering measures. In the same Editor, you can clear the filter. 
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6.4 Predefined Reports 
 

Predefined reports allow helpdesk managers and agents to quickly and easily 

retrieve information for common inquiries. Reports play a vital role as far as a 

Help Desk product is concerned. Requests that are open, closed or overdue at 

any instant of time, which person is sending the most number of requests & 

who is attending to the requests can all be known from the readymade 

reports available with the statistical tool. Each pre-defined report works in 

both OLAP grid and OLAP chart view.  

  

There are several predefined reports in each of the report categories, and 

each report is run directly on a mouse-click from the tree view. Around 40 

reports are made available for instant details about the help desk activities. 

Any of the predefined reports can be also be edited so you can customize the 

report to return specific results: 

 

• Reports by Cases 

• Reports by Callers 

• Reports by Date/Time 

• Reports by Problems 

• Reports by technicians 

 

All these categories have reports available based on Priority, Requester, 

Technician, Category and Request Date. 

 
 

Some sample OLAP charts of the predefined reports 

 

 B) Cases Count by Origin 
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C) Average time spent on caller 

 

 

D) Due date  

 

 
  

E) Cost per problem category 

 

 

F) Time spent by technician 

 

 

  

 

 

 

 

 

 

 

  

  



 

 

 Back to TOC 

P
ag

e9
3 

6.5 Printing, exporting statistical data and charts  

 
Now that you have successfully designed a report, you might want to save it for future reference or share it with others. 

Reuse your work! You can now save data snapshots to HTML, BMP, CSV, GIF, HTML, JPEG, PDF, PNG, TIFF, TXT, XLS and XML 

as a simple way of reusing your data for documents and spreadsheets. Depending on the active view (Grid or Chat), the saved 

file would either take the grid data or the chart. 

 

 

 

 

Available export formats in Chart View  Available export formats in Grid View 

Printing 
You can print your report to share it with others using the built-in Print Preview window. You can tune your page/printer settings 
before printing. Also, if you feel like sharing the report through the net or by email you can easy export it to a wide range of formats 
including PDF, XLS, CSV, JPG, etc. 

 

 

Export Settings -This tool allows you to customize the appearance of the reports to be printed or saved to a file format. You can 
specify the page size, orientation, headers & footers and color of the fonts and page background. 
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7. Uninstalling AssistMyTeam Helpdesk Manager add-in  
 

To uninstall the AssistMyTeam Helpdesk Manager add-in from your computer, follow the steps outlined below: 

 

Step 1: Go to ‘Control Panel > Programs and Features’.  Scroll down to select ‘AssistMyTeam Helpdesk Manager (x86) or 

(x64)’ and click ‘Uninstall’ as illustrated below: 

 

 
 

Step 2: A dialog confirmation follows asking for confirmation. Click Yes.  

 

 
 

Step 3: The AssistMyTeam Helpdesk setup will now start the un-installation process. Make sure that Microsoft Outlook is not 
running (even under the task manager). 

 
Step 4: Uninstalling the add-in does not remove the helpdesk database from your SQL Server or Azure Cloud server. You will need to 

manually delete that database. 
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8. Important links  
  

AssistMyTeam Helpdesk for Outlook - Home page 
Go to the official website of AssistMyTeam Helpdesk for Outlook.  

  

Video Tutorial clips  
Watch video tutorials that teach you how to install, configure and work with AssistMyTeam Helpdesk.   

   

Purchase License  
Purchase an enterprise team license for AssistMyTeam Helpdesk for Outlook.   

   

Knowledgebase articles  
Looking for an in-depth understanding of this application? Browse through a series of knowledge base articles 

on AssistMyTeam Helpdesk online.  

   

Support Maintenance contract  
At AssistMyTeam, we're committed to give you the best support for all the products that we offer and more! 

The AssistMyteam Support Contract helps you use our products more efficiently and work out any issues that 

you encounter during the course of their use.   

   

Submit an online support ticket  
Use this web form to create a ticket with AssistMyTeam Technical Support.   

 

  

https://www.assistmyteam.com/helpdesk-addins/
https://www.assistmyteam.com/helpdesk-addins/
https://www.assistmyteam.com/helpdesk-addins/video-tutorials/
http://www.assistmyteam.net/TeamTimeSheet/TutorialClips.asp
https://www.assistmyteam.com/helpdesk-addins/purchase/
http://www.assistmyteam.net/TeamTimeSheet/Purchase.asp
https://www.assistmyteam.com/helpdesk-addins/kb/
http://assistmyteam.net/KB/index.php?option=com_content&view=category&id=3
https://www.assistmyteam.com/support/
http://www.assistmyteam.net/support/
https://www.assistmyteam.com/support/submit-ticket/
http://www.assistmyteam.net/support/submitTicket.asp
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